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Section 3
Charts
By the end of this section you should be able to:
Create Combination Charts / 2 Axes Charts
Edit and Format Charts
Create and Edit Flowcharts
Create Cycle and Pyramid Diagrams
Animate Charts

Work through the Driving Lessons in this section to gain an understanding of
the above features.
For each Driving Lesson, read all of the Park and Read instructions and then
perform the numbered steps of the Manoeuvres. Complete the Revision
exercise(s) at the end of the section to test your knowledge.
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Driving Lesson 25 - Combination Charts
Park and Read
A combination (or mixed) chart plots different data series in different styles.
For example, rainfall could be plotted as columns whereas temperature could
be plotted as a line on the same grid. If the two data series are completely
different, 2 Axes – one on the left and one on the right of the chart – can be
used.

Manoeuvres
1.

Start a new blank presentation.

2.

Change the layout of the default slide to Title and Content.

3.

Add the title Sales Figures.

4.

Click the Insert Chart butto,
, in the middle of the lower placeholder to
open the Insert Chart dialog box.

5.

Click OK to create a chart in the default Clustered Column format.

6.

The chart’s datasheet will appear (with sample data). Change the values
to those shown below (including deleting rows 4 and 5).

7.

Click the Switch Row/Column button on the Design tab.
You can move the datasheet window if it is in the way.

8.

Close the datasheet window and return to PowerPoint.
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Driving Lesson 25 - Continued
9.

The units for Sales Value (currency) and Units Sold
(quantity) are quite different, so a 2 axes chart should be used.
Click Change Chart Type.

10. From the left of the Change Chart Type dialog box select Combo.
11. For the Sales Value series, select the Clustered Column option, and for
Units Sold, select the Line option. These should already be selected.

12. Check the Secondary Axis box for Units Sold. This data series will now
be plotted using a new axis on the right of the chart.

13. Click OK. The axis for the Sales Value figures (blue columns) is on the
left and is called the Vertical Value Axis. The axis for the Units Sold
figures (orange line) is on the right and is called the Secondary Vertical
Value Axis.

14. Save the presentation as Charts and leave it open.
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Driving Lesson 26 - Editing Charts
Park and Read
Charts can be edited to show data in different ways. For example, the type of
chart or a single data series can be changed, the scale of the value axis and
the interval between the plotted numbers can be amended, the way figures are
displayed can be changed, and labels and legends can be formatted.

Manoeuvres
1.

Using the Charts presentation, right click the Sales Value axis (on the
left) and select Format Axis. The Format Axis task pane appears.

Alternatively, display the Chart Tools - Format tab and click the Chart
Elements drop-down box in the Current Selection group. Select Vertical
(Value) Axis and then click the Format Selection button.

2.

The lowest amount plotted is 18900, so the lowest figure on the Sales
Value axis can be changed. Change the figure in Minimum to 10000.

3.

Change the Maximum value to 25000.

4.

The Major Units interval between each value on the axis is currently set
at 2000. Change this to 2500 and notice the effect.

5.

To change the Sales Value axis units to thousands (without amending the
datasheet), click the drop-down arrow next to Display units.

6.

Notice the many different display units available; hundreds, thousands,
millions, billions, etc. Select Thousands and notice the effect.

7.

Close the Format Axis task pane.

8.

With the Sales Value axis still selected, use the Home tab to change the
font colour to blue.

9.

Select the Units Sold axis on the right (Secondary Vertical (Value)
Axis) and make sure the Chart Tools - Format tab is displayed.
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Driving Lesson 26 - Continued
10. Click Format Selection from the Current Selection group as another
way of displaying the Format Axis task pane.

11. Change the Minimum to 600, the Major Units to 120, and the Display
units to Hundreds. Change the font colour to red.

12. A chart title is added automatically. Click the Chart Title once to select it
and again to place the cursor. Change the text to Sales Period 1 and font
to Tahoma, size 20.

13. With the title still selected, display the Chart Tools - Format tab and click
Format Selection.

14. Using the Format Chart Title task pane, expand Fill and apply a solid fill
of light blue to the title.

15. Click the chart legend. The task pane will change to Format Legend.
Apply the same pale blue solid fill. Close the task pane.

16. With the legend still selected change the font to Tahoma, size 16.
17. Click on any blue column to select the Sales Value series. On the Chart
Tools - Design tab, click Add Chart Element and select Data Labels |
Inside End. Data labels appear at the top of each column.

18. Click Add Chart Element again and select Data Labels | Outside End.
Data labels appear above each column, which looks a little better.

19. Click any data label to select them all. Change the font to Tahoma, Bold.
20. Select the Sales Value axis label, Thousands, and change the font to
Tahoma. Repeat this for the secondary axis label, Hundreds.

21. Select the Horizontal (Category) Axis (Week 1, Week 2, etc.) and
change the font to Tahoma also.
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Driving Lesson 26 - Continued
22. Pictures can be applied to various parts of a chart. With the Chart Tools Format tab displayed, click the Chart Elements drop-down button in the
Current Selection group.

23. Select Chart Area and click Format Selection. Make sure Fill is
expanded and click Picture or texture fill.

24. Click File under Insert picture from and select the file Bridge from the
data files folder. Click Insert.

25. With the Format Chart Area task pane still open, click the Plot Area of
the chart to select it (or use the Chart Elements box).

26. In the Format Plot Area task pane, select Picture or texture fill again.
27. Click File under Insert picture from and select the file pink and blue
from the data files folder. Click Insert.

28. Click one of the blue data columns. The Format Data Series task pane is
displayed.

29. Make sure Fill is expanded and click Picture or texture fill.
30. Click File under Insert picture from and select the file Cat from the data
files folder.

31. Click Insert.
32. Select the Stack option from the task pane.

Pictures are applied to bars in bar charts in the same way.

33. This is quite confusing visually. Change the Sales Value data series back
to a blue solid fill and close the Format Data Series task pane.

34. The Sales Value data series should still be selected. To change the chart
type for the Sales Value data series only, display the Chart Tools Design tab and click Change Chart Type.

35. From the Chart Type drop-down list for Sales Value, select the first of the
Line chart options and click OK. Now both data series are shown as lines.

36. To change the chart type for the entire chart, make sure that no data
series is selected and click Change Chart Type from the Chart Tools Design tab.

37. Select the first of the Column Chart options and click OK.
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Driving Lesson 26 - Continued
38. The new chart has only one vertical axis starting at 10 Thousand and the
Units Sold data is not seen. Display the Format Axis task pane and, with
the Sales Value axis selected (Vertical (Value) Axis), set the Minimum
value back to 0. Close the task pane.

39. Click any data column and click Format Selection from the Chart Tools Format tab.

40. With Series Options expanded, drag the Gap Width slider down to about
40%. All data columns become wider.

41. Drag the Series Overlap slider up to about 40% then close the task pane.
All data columns now overlap.

42. Save the presentation and close it.
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Driving Lesson 27 - Animating Charts
Park and Read
Charts can be animated so that information is displayed in a specified order.

Manoeuvres
1.

Open the Chart Test presentation and select the chart.

2.

To animate the chart, display the
Animations tab and click the More
button in the Animation group’s gallery
to display more effects. Select Wipe.

3.

Click the dialog box launcher,

4.

Select the Chart Animation tab on the dialog box. From the Group chart
drop-down list, select By Category. Make sure the Start animation…
option below it is checked.

5.

Click OK. Then click the Start From Beginning button,
, on the Quick
Access Toolbar to run the slide show. A mouse click is required to
display the chart background, then each further click displays a category.

6.

End the slide show. Click the Animations dialog box launcher again and
display Chart Animation. To change the order in which the data is
animated, change Group chart to By Series. Uncheck the Start
animation… option this time and click OK.

7.

Run the slide show. Now the background appears automatically and each
click displays a complete data series. End the slide show.

8.

Click the Effect Options button. Change Sequence to By
Element in Series and run the slide show again. Now the
background appears automatically and each click displays a
single column in a data series.

9.

Experiment with different animation effects, then close the presentation
without saving.
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Driving Lesson 28 - Creating a Flowchart
Park and Read
Flowcharts on slides can be created by combining preset Shapes available
within PowerPoint.

Manoeuvres
1.

Start a new blank presentation. Change the default layout of the first slide
to Title Only and name it Flowchart.

2.

Display the Home tab and, from the Drawing group’s Shapes button,
select the Flowchart: Terminator shape, .

3.

To start the flowchart, draw the shape at the top left of the slide (under the
title) and type in Order Received. Flowchart shapes can be moved,
resized and coloured like any other drawn object.

4.

Beneath this shape draw a Flowchart: Decision shape,
New Customer?

5.

Beneath this shape draw a Flowchart: Process shape,
customer details to database.

6.

Using smart guide to align shapes, complete the flowchart as below (Add
order details to database; Send Confirmation; Pass to Despatch).

7.

Click and drag over all shapes to select them. On the Home tab, click the
Quick Styles button in the Drawing group and apply Subtle Effect Blue, Accent 1. Click away from the shapes to see the effect.

8.

To connect the shapes, select the basic Arrow, , from the Lines section
of Shapes. The mouse pointer on the slide becomes a crosshair, .
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Driving Lesson 28 - Continued
9.

Notice how black handles appear as the
mouse pointer is moved over the shapes.

10. Click and drag the bottom centre handle of
the Order Received shape towards the New
Customer? shape.

11. Drag the line to the top handle of the New Customer? shape it will ‘snap’
into place. Release the mouse button to anchor the line.

12. When the connector has green handles at each end, it is locked to the
shapes. Move the New Customer? shape to the left. The connector will
follow it. Click Undo to return the shape to its original position.

13. In a similar way, use the Elbow Arrow Connector line,

, to join New
Customer? To the top handle of Add order details to database.

14. Join the other shapes as shown below.

15. Save the presentation as Flowchart and leave it open.
Flowcharts can also be created using other applications and then imported into
PowerPoint. For example, a flowchart can be created and saved in Microsoft
Visio and then inserted onto a slide using the Insert Object command.
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Driving Lesson 29 - Amending a Flowchart
Park and Read
The shape and position of components in a flowchart can be changed or
deleted as necessary.

Manoeuvres
1.

Using the flowchart created in the previous lesson, right click any shape
and select Set as Default Shape. This sets the format for future shapes.

2.

Add a new terminator shape above Pass to Despatch and type End.

3.

The Pass to Despatch shape is the wrong type. Remove it from the
flowchart by selecting the shape (not the text) and pressing <Delete>.

4.

Insert a Flowchart: Predefined Process shape, , in the gap and type
the text Pass to Despatch. Align the shape if necessary, and then
connect it to the End shape with a Straight Arrow Connector.

5.

Click the arrow between Send Confirmation and Pass to Despatch. If
necessary, drag the right handle to reconnect with the left edge of Pass to
Despatch.

6.

Remove the connector between Add customer details to… and Send
Confirmation by clicking on it and then pressing <Delete>.

7.

Join the right edge of Add customer details to... to the top of Add order
details to… using an Elbow Arrow Connector.

8.

Adjust the position of the line using the yellow handles that appear when it
is selected. The chart should appear as follows:

9.

Save the presentation and close it.

PowerPoint 2016

57

© CiA Training Ltd 2016

Section 3 Charts

ECDL Advanced

Driving Lesson 30 - Creating Other Diagrams
Park and Read
PowerPoint helps you create various diagrams to help explain concepts in your
presentation. These include cycle diagrams, which show the circular
relationships between processes, and pyramid diagrams, which are divided
into horizontal slices to represent a hierarchy.

Manoeuvres
1.

Open the presentation Theatre.

2.

Insert a new Title and Content slide at the end.

3.

Add the title Workshop Teaching Cycle.

4.

Click the Insert a SmartArt Graphic button,
, in the lower placeholder
to display the Choose a SmartArt Graphic dialog box.

5.

Click Cycle from the left and select the first option (Basic Cycle).

6.

Click OK to create the SmartArt graphic.

7.

The first component of the Cycle diagram is selected. Type the text
Practice and Learn.

8.

Select the next component (clockwise) and enter Test.

9.

Select the third component and enter Assess.

10. Click the fourth component and press <Delete> to remove it. Remove the
last component too, leaving three. Notice that the chart is automatically
realigned (as shown on the following page).
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Driving Lesson 30 - Continued

11. Insert a new Title and Content slide after slide 2. Add the title
Organisation.

12. Click Insert a SmartArt Graphic and select the first Basic Pyramid
option. Click OK.

13. On the bottom level enter Support Staff, on the middle level enter
Administration, and on the top level enter Director.

14. Display the SmartArt Tools - Design tab and select one of the SmartArt
Styles.

15. Click the Change Colors button and select one of the colour schemes
from the Colorful range. Click away from the pyramid chart to see the full
effect.

16. Click on the Director level, display the SmartArt Tools - Design tab and
click the drop-down arrow on Add Shape from the Create Graphic group.

17. Select Add Shape After. A new shape is added. Type in Management.
18. Click the Director shape (not the text) and press <Delete> to remove it.
19. With the top shape in the pyramid selected (the mouse pointer changes to
a four-way arrow), drag it to the right. Drag the second level to the left.

20. Right click on the top shape and select Reset Shape to return it to its
original position. Click Reset Graphic on the SmartArt Tools - Design
tab to restore the whole diagram to its original formatting.
Manipulating shapes is similar in all types of diagram.

21. Save the presentation as Theatre2 and close it.
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Driving Lesson 31 - Revision
Park and Read
At the end of every section you get the chance to complete one or more
revision exercises to develop your skills and prepare you for your ECDL
certification test. You should aim to complete the following steps without
referring back to the previous lessons.

Manoeuvres
1.

Open the Assessment presentation. At the end of the presentation, insert
a new Title and Content slide and add a title of Pass Rates.

2.

Add a Clustered Column chart and amend the datasheet as below.

3.

Make sure the chart has this layout.

4.

Close the datasheet.

5.

Change the Actual data series to be a line chart.

6.

Change the Minimum scale to 70 and the Maximum scale to 100.

7.

Animate the chart to introduce elements By Category with the effect
Wipe, (From Left).

8.

Save the presentation as Revision31. View the slide show for this slide
and use the mouse button to introduce each section of the chart.

9.

Close the presentation.
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Section 5
Slide Shows
By the end of this section you should be able to:
Create and Edit Action Buttons/Hyperlinks
Control a Slide Show
Create and Edit Custom Shows
Run a Custom Show
Apply Slide Transitions
Apply Timings
Set up a Slide Show

Work through the Driving Lessons in this section to gain an understanding of
the above features.
For each Driving Lesson, read all of the Park and Read instructions and then
perform the numbered steps of the Manoeuvres. Complete the Revision
exercise(s) at the end of the section to test your knowledge.
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Driving Lesson 39 - Action Buttons
Park and Read
Action buttons use hyperlinks to allow easy navigation between slides during
a presentation. Action buttons also allow movement to other presentations, files
and web sites.

Manoeuvres
1.

Open the Training presentation and save it as Training2.

2.

Select slide 4, The Open Learning Guide. Let’s create an action button
that links to slide 7.

3.

On the Home tab, click the Shapes button and take a look at the Action
Buttons section (at the very bottom of the list; you may need to scroll).

4.

Select the Information action button,

5.

Draw your new button at the bottom left side of the slide.

6.

The Action Settings dialog box appears. Make sure that the Mouse
Click tab is selected. Select the Hyperlink to option, click the drop-down
list below it and select Slide.

7.

A list of slides in the presentation is displayed. Select slide 7. Where to
Get More Information.

8.

Click OK, then OK again to close the dialog box.

9.

Display the Slide Show tab and select From Current Slide to see the
slide as it will appear in the presentation.

.

10. Click the action button. The presentation jumps to slide 7 (Where to Get
More Information).
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Driving Lesson 39 - Continued
11. The presentation will continue from its new position (there is no automatic
return to the original slide). Click until the show is ended.

12. With slide 7 displayed, draw a Custom action button,

, which will link to

a separate presentation.

13. In the Action Settings dialog box, select Hyperlink to again and then
Other PowerPoint Presentation from the drop-down list below it.

14. Select the presentation file CIA Seminar from the data files folder.
15. Click OK and make sure Hyperlink to Slide shows Slide 1 highlighted.
Then click OK.

16. Click OK to create the link. With the new action button selected, type CIA
so it is labelled.

You can resize and format an action button like any other object in PowerPoint.

17. View the slide show from the current slide. Click the CIA action button to
view the linked show. End the CIA show to return to the Training2 show.

18. Press <Esc> to end that show too.
19. At the bottom left of slide 5, draw a Document action button,

. This will

link to a Word document.

20. From Action Settings select Hyperlink to then Other File.
21. Select the Sample data file document and click OK then OK again.
22. Add the text Sample to the button.
23. Run the show from the current slide and click the Sample action button.
Word starts and opens the document.

24. Close Word, without saving if prompted and end the show.
25. Right click on the Sample button and select Edit Hyperlink. To remove
the hyperlink from an action button, select None from Action on click
and click OK.
Alternatively, right click on the button and select Remove Hyperlink.

26. Hyperlinks can also be applied to text or graphical objects; you don’t
always have to use action buttons. Display slide 7 and select the text
Information.
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Driving Lesson 39 - Continued
27. Display the Insert tab and click the Hyperlink button from the Links
group.

28. Make sure Existing File or Web Page is selected on the left and type
www.ciatraining.co.uk in the Address box. PowerPoint adds the
necessary components to make this a valid web address.

29. Click OK.
30. Run the show from slide 7. The text Information is displayed in a different
colour to indicate it is a hyperlink. Move your mouse pointer over the
Information text and it changes to a hand cursor.

31. Click on the hyperlink. Your browser application will start and the CiA
Training home page will be displayed (if you are connected to the
Internet).

32. Close the browser window and end the slide show.
Hyperlinks can be removed from any object, including text, by right clicking
them and selecting Remove Hyperlink.

33. Save the presentation and leave it open.
Action buttons are great for unattended presentations (e.g. presentations that
run in a kiosk). Users can use the action buttons to move to different slides.
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Driving Lesson 40 - Editing an Action Button
Park and Read
It is possible to change the destination of an action button (or any hyperlink)
after creating it. This may be necessary if a web address (URL) or a file
location changes.

Manoeuvres
1.

On slide 7, right click on the CIA action button (take care not to click the
text content, you need to click part of the button itself).

2.

Select Edit Hyperlink. The current hyperlink destination is shown.

3.

To change the link to a different presentation, click the Hyperlink to dropdown list.

4.

Click on Other PowerPoint Presentation.

5.

Select the Holiday Choice presentation from the data files folder and
click OK, then OK again to accept Slide 1 as the destination of the link.

6.

Click OK in the Action Settings dialog box.

7.

View the slide show for this slide and click the button to view the new,
linked presentation. Use <Esc> key presses to end both shows.

8.

On slide 7, right click on the word Information.

Notice there is an option here to Remove the hyperlink
from this text.

9.

Select Edit Hyperlink.

PowerPoint 2016

75

© CiA Training Ltd 2016

Section 5 Slide Shows

ECDL Advanced

Driving Lesson 40 - Continued
10. Highlight the text in the Address box and type www.ecdl.org.
11. Click OK.
12. Run the show from slide 7.
13. Click on the Information hyperlink text. If you are connected to the
Internet, your web browser will start and the ECDL home page will be
displayed.

14. Close the browser window and end the slide show.
15. On slide 7, right click on the CIA button and select Remove Hyperlink.
16. Run the show from slide 7 again.
17. Click on the CIA button text. The button no longer contains a hyperlink
and so nothing happens.

18. End the show.
19. On slide 7, right click on the Information hyperlink text and select
Remove Hyperlink.

20. Close the presentation without saving.
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Park and Read
A custom show allows you to select specific slides to include in a presentation
(those not selected will be skipped during the slide show). This lets you create
multiple versions of the same presentation for different audiences.
For example, a company presentation could be created to summarise the year
ahead. When presented to sales people, additional slides on performance and
targets could be included. When presented to finance staff, slides on budgets
and tax changes could be shown instead.

Manoeuvres
1.

Open the Business presentation.

2.

On the Insert tab, click Header & Footer in the Text group and
check the box to include Slide number. Click Apply to All.

3.

Notice the slide number in the lower right corner. This will help you identity
slide numbers during the show. Save the presentation as Custom.

4.

The presentation is to be shown to two different departments at the same
company: Finance and Marketing. To avoid the creation of two separate
presentations, two custom shows are to be created instead, each showing
a different selection of slides.

5.

On the Slide Show tab, click Custom Slide Show then Custom Shows
to display the Custom Shows dialog box. Click the New button to open
Define Custom Show.

6.

In the Slide show name box, rename the custom show Finance. This will
be the show given to that department.

7.

Check the box for slide 1 below Slides in presentation, then click Add. It
appears in the Slides in custom show box on the right.
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8.

The Finance people do not need to see all of the Marketing slides. Select
slides 2, 4, 9, 11 and 12, then click Add to add them to the custom show.

9.

Click OK to return to the Custom Shows dialog box.

10. Click New to create another custom show. Rename it Marketing and
include slides 1, 2, 3, 4, 6, 7 and 12.

11. Click OK. To edit the Marketing department’s show, select Marketing
from the list in the Custom Shows dialog box and click Edit.

12. Click on slide 6. Business Concept on the right of the dialog box.
13. Click Remove,

, to delete it (from the custom show only).

14. Slide 4. The Team is to be moved after 5. Opportunities. Select slide 4
from the right of the dialog box.

15. Click Down,

.

16. Click OK and then Close.
17. Save the presentation and leave it open.
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